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OVERVIEW OF HYPERLINKING IN FEDERAL COURT 
 

In the internet research world, hyperlinks are a standard way of “drilling down” 
for more detail or specific information.  Just as all web pages contain links to other pages, 
cases downloaded from legal research services such as Westlaw or Lexis contain links to 
the cases, statutes, articles, or other sources cited within the opinion.  The links allow 
immediate access by the reader to these referenced materials.   

Attorneys can include links to cited law and previous CM/ECF filings in their 
documents to be filed in CM/ECF, adding another level of persuasion to their writing.  
Hyperlinks in briefs and other court filings provide quick, easy, and pinpoint access to 
particular sections of a case, or to specific filings in the court’s record.  The attorney can 
thereby highlight the precise issue presented, and the specific evidence and controlling 
or persuasive law the court should consider.   

Hyperlinks in court filings are very beneficial for court chambers.  Court 
submissions which include links to relevant case law and case filings are easy for 
chambers staff to review.  The attorneys’ arguments can be immediately verified in the 
context of the relevant law.  The judge or judicial clerk is able to read the text of the cited 
case law on one screen while reading the attorney’s brief on the other.  And if a brief 
contains links to referenced exhibits, and even to specific pages within those exhibits, the 
judge or judicial clerk can access the relevant evidence without having to navigate 
through the CM/ECF record.  Particularly when dealing with large and complex cases, 
links save chambers considerable time and effort.  Links make it easy for the court to 
verify – and adopt – the positions taken by an advocate. 
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Types of Permissible Hyperlinks 
 

The following types of hyperlinks are typically allowed in court documents.  
 

 

 

 

  

Internal Links For example, the Table of Contents located at the beginning 
of this Guide. 

Links to documents 
previously filed in CM/ECF 

 

Links to attachments and 
exhibits being filed with 
your brief 
  

Note:  Evidence must be filed of record.  A hyperlink to a 
public website where evidence can be found is not a 
substitute for filing evidence in support of a motion. 

Links to case and statute 
citations 

 

Note:  Unless a cited case 
cannot reasonably be found 
from a public source, it is not 
necessary to attach copies of 
cases or statutes to your brief.   

 

 

For example: 

Westlaw, 

 
Lexis, 

 

 

 

or court websites. 
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CREATING A HYPERLINKED TABLE OF CONTENTS 

  

A table of contents in a MS Word document can include internal hyperlinks for 
navigating the document.  When the document is converted to PDF format, these links 
will become bookmarks in the PDF document.  

Although there are several methods for creating a table of contents in MS Word, 
the one most useful to attorneys (and discussed below), is to create the document, include 
any headings as you write, and then: 

 
• Mark and format the headings to be included in the table of contents; 
• Generate and insert the table of contents; and  
• Edit as needed. 

 

Marking and Formatting Table of Contents Entries 
 

To mark and format entries to be included in the table of contents: 

STEP ACTION 

1 Create your document, inserting all headings with the format of your choice.     

2 Using your cursor, scroll over and select 
the heading you want to include in the 
table of contents. 

3 From the Styles 
section on your 
Home tab,  

 
Click the down arrow in the right  
lower corner.  

 

A drop-down list will appear.  

 

Note:  There are several pre-formatted Heading Styles 
available in MS Word, but only 2 may be visible in your 
styles drop-down menu.  Additional heading options will 
appear as you make your selections.  For example, when 
you select and apply Heading 2, the Heading 3 option will 
appear and be available for the next heading level, and so 
on.  
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4  
If… Then… 

You want the 
text of the table 
of contents 
entries to match 
the headings 
already created 
within your 
document (e.g. 
font, font color, 
bold, etc.):  

Use your cursor to select the heading to be included in the 
table of contents.  

 
From the Styles list, Right-click the heading level you wish 
to apply. In the box that appears, select:  

Update Heading [x] to Match Selection. 

Continue until a heading style has been applied to all 
heading levels within your brief. 

You want to: 

Set a standard 
format (e.g. font, 
font color, bold, 
etc.), for all 
headings and 
table of contents 
entries created 
with your Word 
program,  
 
      Or 

 
Change the 
heading format 
in the brief 
already created: 

From the Styles list, 

Right-Click the heading level 
you wish to modify.   

In the box that appears, select 
Modify to open the Modify 
Style box.   

 
 
Choose text:  

• font 

• font size 

• appearance 

• color 

• justification 

• line spacing 

 
Save settings for: 
• only in this document, or 
• all documents created using your standard template. 
• Add to Quick Style List. 

Click OK. 
  

 
Scroll through your document.  For each heading, select the heading text with your 
cursor, then click the heading style to be applied. 
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Generating and Inserting the Table of Contents 
 
To add the Table of Contents to your document: 

STEP ACTION 

Place your cursor in 
the document at the 
location you want 
to insert the table of 
contents. 
 
Add a title for the 
Table of Contents. 
 
Enter a few hard 
returns.  
 
(You may want to 
select the 
Show/Hide 
Paragraph Marks 
on the Home tab.) 
 
Control + Enter to 
insert a page break.  

 

 

Place your cursor 
where the table of 
contents entries 
should begin.   

 
From the  
References tab of 
your Word ribbon,  
 
Select:  
 
Table of Contents, 
and from the menu 
that appears,  
 
Select: 
 
Insert Table of 
Contents. 
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Make selections for 
the appearance of the 
table of contents. 

Click OK.  

Note:  If your table 
has more than three 
levels, you must set 
Show levels to the 
correct number. 
 
Note:  The “Use 
hyperlinks instead of 
page numbers” must 
be checked or the 
table of contents will 
not have active links 
upon conversion to 
PDF.  

 

The Table of 
Contents, with active 
section links, will be 
inserted into your 
document.  
 
Note:  You can 
manually modify the 
page numbers to 
appear as other links 
in your document, 
(e.g. blue and 
underlined).  

 
 

Editing the Table of Contents (if needed) 
 

Inserting the Table of Contents may result in page break changes.  For example, 
hard page breaks or extra lines that were added during drafting to adjust the 
overall look of the document may no longer be needed, or some may now need to 
be added.   

If the brief was modified after the table of contents was inserted: 
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STEP ACTION 
From the reference tab on the 
Word ribbon, select Update 
Table. 
 

 

Select  

Update page numbers only.   

Click OK. 

Note:  If you have added or 
changed a heading, choose 
Update entire table. 

 

 

When the entire document is complete, using MS Word, Save the document as a 
PDF or Create PDF in accordance with the instructions in this Guide.   

Note:  Do not Print to PDF.  All active links in your Word document become 
inactive in PDFs created using Print to PDF. 
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DRAFTING DOCUMENTS TO INCLUDE LINKS TO CM/ECF 

 

If you are creating a document which will include links to documents filed in 
CM/ECF, use a consistent citation format that cites the CM/ECF filing number along 
with the CM/ECF page number. For example: 
 

STEP ACTION 
1 Download the filings from CM/ECF and save them in your computer. 

Reminder: You can download a document from CM/ECF one time for free 
when you receive the Notice of Electronic Filing ("NEF"). Charges apply to 
each additional download of the same document.   
 

2 Documents downloaded from CM/ECF will include a header that identifies 
the CM/ECF filing number and the page numbers within that filing.  

 
3 When drafting your brief, cite to the CM/ECF filing number and CM/ECF 

page number to which you are citing. For example: 
 
Assume you are citing to the following page of evidence: 

 
The citation within the brief should appear as follows: 

 

  

 
 
 

Gathering URLs for Documents Previously Filed in CM/ECF 
 

Now that the filing numbers and associated page numbers, if applicable, are in 
the brief, you can manually add links to the electronic record.  
 
You may manually gather links one of two ways: 
 
• Option 1:  Saved Notices of Electronic Filing (no charge); or  
• Option 2:  The docket sheet on PACER (PACER charge applies). 

 

The exhibits have been disposed of.  (Filing No. 476, at ECF p. 1). 
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Option 1:   To obtain the URL for the CM/ECF document without incurring a 
PACER charge: 
 

STEP ACTION 
1 Collect and save on your computer the Notice of Electronic Filing (NEF) for 

all filings in the case.  
Reminder: You can download a document from CM/ECF one time for free 
when you receive the Notice of Electronic Filing.  Charges apply to each 
additional download of the same document. 

2 Documents downloaded from CM/ECF will include a header that identifies 
the CM/ECF filing number and the page numbers within that filing. 

 
 

3 When you are ready to add the link for 
the document cited,  
--Retrieve the NEF for that document, 
--Right-click on the Document 
Number, and from the drop-down 
menu that appears,  
Select Copy Shortcut. 

4 For manually inserting the hyperlink, proceed to the next section, Manually 
Inserting Links Previously Filed in CM/ECF 

 
Option 2:  To obtain the URL for the document from the PACER docket sheet  
   (PACER charge applies): 

 

STEP ACTION 

1 Open the CM/ECF docket sheet for the case and scroll to the cited docket 
filing. 
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STEP ACTION 

2 If linking to the main CM/ECF filing,  

Right-click on the docket filing number 
and select Copy shortcut. 

 
 

 
 

If linking to a sub-file within a CM/ECF filing number: 

Either: 

Click on the docket filing number;    

 
 
A window will open which lists all sub-
filings  for that docket filing number. 
 
Place your cursor over the link for the 
document you are citing,   
 
Right-click, and from the drop-down 
menu that appears, and  
select Copy Shortcut. 

 

Or  

Right-click on the sub-
filing number in the 
docket text and, 
select Copy Shortcut.  

 
 

3 For manually inserting the hyperlink, proceed to the next section, Manually 
Inserting Links Previously Filed in CM/ECF 
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LINKING TO CM/ECF DOCUMENTS 
 
Below are two methods to insert hyperlinks in a document to be filed in 

CM/ECF: 
 
• Manually Inserting Links to Documents Previously Filed in CM/ECF; and 
• Add Links to Attachments to the Document Being Filed in CM/ECF  
 

Manually Inserting Links to Documents Previously Filed in CM/ECF 
 

To manually add the links you have copied from the docket to the MS Word 
document you are drafting: 

STEP ACTION 

1 In the brief, use your cursor to select the citation to which a hyperlink will be 
added. 
 
 
 

2 Select the Insert tab on the MS Word ribbon, then select Hyperlink. An 
Insert Hyperlink dialog box will appear. (Or right-click and select 
Hyperlink from the drop-down menu.) 

 
Note: The text you selected will automatically appear in the “Text to 
display” line. 

The defendant is a Colorado citizen (Filing No. 13-1, at 
ECF p.3) 
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STEP ACTION 
3 Place your cursor in the Address box of the Insert Hyperlink dialog box. 

Right-click. From the drop-down that appears, select Paste. (The link to 
paste will be the link gathered by following the instructions in the previous 
section.) 
 

 

4 The link to the first page of the filing will appear. 
 
To link to the filing only, or to only page 1 of the filing, click OK. The link to the 
citation will be added in your brief. 

 

5 To link to the specific page number of the CM/ECF filing that you are citing, 
 
In the address box, scroll to or place your cursor at the end of the link 
address. 
 
Add the following text: #page=<page number> .  For example, 
 
To link to page number 3 of a filing, add #page=3.  Click OK and the link to 
the page will be added to the citation in the brief. 
 

 
 
Note: Use the page numbers assigned by CM/ECF when linking to pages in 
documents filed in CM/ECF.  Do not use Bates numbers or other numbering 
assigned to the record by the parties. 
 
Note: While the document remains in an MS Word format, the link will go 
only to the first page of the document. But upon conversion to PDF (see 
instructions below), the PDF link will go to the specific page cited. 
 
Note: For outside users (PACER), the link will always go to the first page of 
the document, but for court staff and judges the page specific links work 
correctly and will go to the correct page.   
 

6 Convert the brief to a PDF following the instructions in this Guide. 
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STEP ACTION 
7 File the PDF version of the document in CM/ECF. 

 
Note: It is not necessary to re-file or re-attach the documents to which you 
are linking if they have been previously filed in CM/ECF. 
 

 

 

Adding Links to Attachments to the Document being Filed in CM/ECF 
 
If a document cited in your brief has not previously been filed in CM/ECF, you 
may link to the document within your brief only if the document is filed as an 
attachment to your brief. Follow the steps below to add active hyperlinks to 
documents you will be filing as brief attachments in CM/ECF. 

STEP ACTION 
1 Save all attachments/exhibits separately into a single folder on your 

computer that you will cite in your brief. The documents must be in PDF 
format. Be sure the names of the files do not contain special characters, such 
as apostrophes or ampersands, as these will break the hyperlinking process.  
 

2 While drafting your brief, include the citations to the documents saved on 
your computer.  

3 Using your cursor, select the text to which a link will be added. 

 

4 On the Insert 
ribbon,  
 
select Hyperlink. 
(Or right-click on 
the text to be linked 
and select Hyperlink from the drop-down menu.) 

5 In the Insert Hyperlink dialog box: 
 
• Navigate to cited file 

saved on your computer;  
• Select the file; and  
• Click OK. 
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STEP ACTION 
6 A link to the file will be added to the text. If you hover over the link with 

your cursor, you will see the link address. 

 
Add links to all the citations in your brief accordingly. 
 
Note: Specific page links can be added by following the directions in the 
previous section. Use the PDF page number, not a Bates number or footer 
page number, for the citation. 

7 Save the brief as a PDF as described in these instructions in this Guide. 

8 File the brief and evidence as follows: 
a Following the normal procedure for filing briefs in CM/ECF, 

browse to and select your document, i.e. Brief with links.pdf, 
as the main document. 

 
b Browse to and select as an Attachment each PDF file to which 

a link was created in your brief.

 
c Using the drop-down list, select the type of document 

attached, and provide a written description of the document.   
(Note:  The written description will become the name 
assigned as a PDF bookmark when the file is downloaded by 
the court.  However, a unique description is needed if 
similarly labeled documents are cited.)   

Repeat the foregoing steps until all cited evidence is filed as 
an attachment to your brief. 

d When all evidence attachments have been added to the brief, 
click Next and complete the remaining steps for filing the 
brief in CM/ECF. Once filed, the links in the brief will link 
directly to the evidence filed of record as attachments to the 
brief. 
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AUTOMATED LINKS TO LEGAL CITATIONS 

  

Links to legal citations can be added manually or, assuming the software is compatible 
with your computer and word processing software, by using automated linking 
software available through Westlaw or Lexis.   
 

Access to Linking Software 
Linking software from Westlaw and Lexis is available from both companies with 
a subscription to their services. The Court does not provide support for these 
services and cannot offer training or other information regarding these services. 

Tool URL 
Westlaw Drafting 
Assistant 

http://legalsolutions.thomsonreuters.com/law-
products/solutions/brief-tools?searchterms=brief+tool 
 

Lexis for Microsoft 
Office  
 
Lexis Brief Check 
 
Lexis Brief Link 

http://www.lexisnexis.com/en-us/products/lexis-for-microsoft-
office.page 
 
https://advance.lexis.com/BriefCheckhome 
 
https://advance.lexis.com/BriefLink 
 
 

 

  

http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief+tool
http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief+tool
http://www.lexisnexis.com/en-us/products/lexis-for-microsoft-office.page
http://www.lexisnexis.com/en-us/products/lexis-for-microsoft-office.page
https://advance.lexis.com/BriefCheckhome
https://advance.lexis.com/BriefLink


Attorney Guide to Hyperlinking in the Federal Courts  
Created by Nebraska District Court, Modified by Indiana Southern District Court 
Created August 1, 2013, Modified by INSD May 24, 2022   Page 18 of 28 

MANUALLY INSERTING LEGAL CITATION LINKS  

 

As previously described, hyperlinks to documents filed in CM/ECF can be 
manually added to a document about to be filed.  It is also possible to manually create 
links to documents available through commercial legal websites (e.g., Lexis or Westlaw).   

Manually adding links can be labor intensive if the document is long, but the 
process is not difficult.  And even if you are primarily using software to add links to a 
document, understanding the underlying mechanics of hyperlinking within 
WordPerfect and Word documents is helpful and may be necessary if, for example, you 
need to make corrections to the automatically created links. 
 

Manually Creating Links to Online Research Resources 
 

The process for manually adding links to Westlaw, Lexis, Google Scholar, or any 
other online research resource (LoisLaw, FastCase, etc.,) is the same. 

STEP ACTION 

1 In the brief, use your cursor to select the citation to which you are adding a 
link. 

 

2 Sign into the legal research website and open the cited document.   
Select the url address for the document. 
 
Right-click, and Copy the address.  See e.g.,  
 

 
OR 

 
OR 

 
 
Note:  Check your local rules for any authority or limitations on the legal 
research websites to which links are permitted. 
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STEP ACTION 
3 a Select the Insert ribbon, then select Hyperlink. An Insert 

Hyperlink dialog box will appear. 

 
Note: The text you selected will automatically appear in the “Text 
to display” line. 

b Place your cursor in the Address box of the Insert Hyperlink 
dialog box. Right-click. From the drop-down that appears, select 
Paste. 

 
Click OK.  

c The link to the citation will be added in your brief. 

  

Manual Links to Court Websites 
 

You may wish to cite to published opinions on a court’s website.  To do so: 

STEP ACTION 
1 In your brief, select the text to be linked. 
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STEP ACTION 

2 Locate and copy the URL address for the citation.  See e.g.,  

 
 

3 Referring to the previous section, “Manually Creating Links to Online 
Research Resources,” complete Step 3.  
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FINAL EDITING 
 

Removing Links 
 

To remove a specific link in a Word document: 

Place your cursor over the link, 
 
Right-click, and from the drop-down 
that appears,  
 
click Remove Hyperlink. 
 

 
 

To remove all links in a Word document: 

Press Ctrl + A to select the entire document, then 

Ctrl + Shift + F9. 
 

Editing Linked Text 
 

To make additions to or change hyperlinked text in a Word document: 

1. Place your cursor at the end of the linked text. 

2. Use the back arrow on your keyboard to move your cursor in the 
linked text to the position where the text must be added or 
changed, and  

3. Type in your changes. 

Or 

Place your cursor over the link, 
 
Right-click, and from the drop-
down that appears, and  
 
click Edit Hyperlink. 
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In the Edit Hyperlink box that 
opens,  
 
Type any changes in Text to 
display. 
 
Click OK. 
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PUBLISH TO PDF—RETAINING THE HYPERLINKS 

 

All documents filed in CM/ECF are in PDF format, so all documents created for 
filing must be converted to a PDF document.  To include hyperlinks in your filed 
documents, place all the links into the document using your word processing system 
before converting the document to a PDF format. 

Once all links are in the word processing version of your document, use your word 
processing software to save or convert your briefs, or other documents you have created 
for filing, in a PDF format.   

Note:  Do NOT use Print to PDF to create a PDF of a brief with hyperlinks–the 
hyperlinks will be lost.  Do NOT print the document and scan it to PDF format. 

 

Conversion to PDF 
 

MS Word has several methods for saving (“publishing”) a document in PDF 
format. It is recommended that you have Adobe Acrobat Standard or 
Professional installed on the computer you will use to convert and follow the 
steps below: 

STEP ACTION 
1 Select the File 

tab on the MS 
Word ribbon; 
 
from the drop-
down menu, 
select  
Save and Send 
or Save to PDF; 
 
and from the 
choices now 
available,  
choose Create 
Adobe PDF 
from the File Types list,  
 

then   
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STEP ACTION 
2 Navigate to the location where you want to save the document. 

Name the document and click Save. 

 
Check View Result if you want the PDF document created to open upon 
conversion. 

3 After the document is published to PDF, you may upload it to CM/ECF 
using typical filing processes.  With the exception of filing a document with 
links to its own attachments (discussed previously), no special steps are 
needed for filing a hyperlinked document on CM/ECF. 

 

Note: If you have Adobe Acrobat Standard or Pro loaded on your computer, 
you may also add the Adobe Acrobat tab and ribbon to your MS Word ribbons 
and use the Acrobat ribbon to convert documents to PDF. 

To do so: 
 
Select the File tab on the MS Word ribbon. 
 
Choose Options.  
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Select Customize Ribbon. 
 
Add the Acrobat tab. 
 
Click OK 

An Acrobat tab will now appear on the MS Word ribbon, and will continue 
to do so hereafter. 

 
After the Acrobat tab is added, save a document as a PDF by selecting the 
Acrobat tab, and then Create PDF. 

 

After the document is published to PDF, you may upload it to CM/ECF 
using typical filing processes.  With the exception of filing a document with 
links to its own attachments (discussed previously), no special steps are 
needed for filing a hyperlinked document on CM/ECF. 
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ADDITIONAL TIPS 

 
 

Viewing a Website Location Opened from a Link in a CM/ECF Filing 
 

When opening a PDF document filed in CM/ECF, make sure you are opening 
PDFs in your PDF software and not within the Web browser itself.  Opening the 
CM/ECF documents in the web browser will result in unnecessary toggling 
between the document opened in CM/ECF and any website locations opened 
from links within that CM/ECF document and will make it difficult or impossible 
to display the CM/ECF document on one screen and the website location on 
another.   

For those who use Adobe Acrobat, this setting adjustment is made as follows: 

With an Adobe Acrobat 
document open, 
 
Click Edit,  
 
then Preferences.   
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From the Categories,  
scroll and select Internet. 
 
Make sure Display PDF in 
browser is not selected.  
 
Click OK. 

 
After you change this setting, you will need to close and reopen your Web browser 
before opening CM/ECF filings. 

 

PDF/A documents 
 

Depending on how a PDF/A document is produced, masked hyperlinks may not 
be preserved.  If the document will contain masked hyperlinks, the user should 
create the document in Word 2007 or 2010 and use the “Save As” (2007 and 
2010), “Save as Adobe PDF” (2010), or “Adobe PDF” (2007) methods to produce 
the PDF/A file. 
 

Optimized PDFs to reduce file size 
 
Large documents or documents containing forms, photos or graphics should be 
saved as an optimized PDF to reduce file storage size.  Select File and Click Save 
As.  From the Save as type dropdown menu, select PDF.  From the Optimize for 
radio buttons, Select Minimum size (publishing online).  Click Save. 
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This Guide was produced by the Nebraska District Court and 
modified by the Southern District of Indiana.   
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